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Style conventions used in this document:

Ul Text: Text that represents elements of the Ul such as button names, menu
options etc. is presented with a grey background and border, in Tahoma
font which is traditionally used in Windows Uls. For example:

Ok

Standard Terms (Jargon): Text that is not English Language but instead refers to

industry standard concepts such as Strategy, BACnet, or Analog Input is
represents in slightly condensed font. For example:

BACnet

Code: Text that represents File paths, Code snippets or text file configuration
settings is presented in fixed-width font, with a grey background and
border. For example:

$config file = c:\CYLON\settings\config.txt

Parameter values: Text that represents values to be entered into Ul fields or
displayed in dialogs is represented in fixed-width font with a shaded
background. For example

10°C

Product Names: Text that represents a product name is represented in bold
colored text. For example

INTEGRA™

Company Brand names: Brands that are not product names are represented by
bold slightly compressed text:

ABB Active Energy

PC Keyboard keys: Text representing an instruction to press a particular key on
the keyboard is enclosed in square brackets and in bold font. For

example:

[CtrI]+[1]
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Note:

Note:

Note:

Note:

CXproHD Site Organizer | Introduction

Introduction
OVERVIEW

The Site Organizer provides you with an easy way to set up files on the Communications Controller and
Field I/O Controllers on an ABB Cylon® Site. It allows you to download strategy, setup, global and keypad
files to all the Comms Controllers and Field controllers on a site in one simple operation. A “site” is a
group of one or more ABB Cylon® Controllers connected together and communicating with each other. A
site usually corresponds to a discrete environment unit, such as a room, a building, or a campus.

A combination of files can be downloaded to any combination of controllers or to one particular type of
controller. Files can be uploaded from the controllers on a site to the supervisor PC.

A download refers to the transmission of a file from a PC to a Cylon® controller.
An upload refers to the transmission of a file from a Cylon® controller to the supervisory PC.

The Site Organizer operates through the use of instructions. The instructions tell the program which files
are to be uploaded from or downloaded to controllers on the site.

The Site and the Controllers must be set up first using CXprotP.

GETTING STARTED

CXpro® must be running.

1. Double-click on the Site Organizer icon in the Utilities group of the Ribbon’s Home tab.

File ~ Home Contraoller Strategy

’Cnnnect @Cnpy Properties PageNames @Searm E m Dr:-;" G o ’QBACnet

X Di ct | [fFPast [#] BACnet Properties [[E] Madul Strategy Hel ' Strat
& Disconnect | [F)Paste net Properties odules rategy Help rategies
i Database Datalog Site MB-Pro  Settings

= Site
L_iSelect All List Mavigation Macros Interface Manager Organiser Reopen Strategies
Site Clipboard View Utilities Settings

The Site Organizer Window will appear:

[T R
§fRe amoms Sded wstemons View Hep |

Bl o e 1

racy

Go to the File menu and sign on, if you have not done so already.
3. Go to the Select menu and choose Site. The Select Site dialog box will appear. Choose the Site to be
configured.

4. Go to the Select menu and choose Targets. The Select Targets dialog box will appear. Select the Comms
Controllers and Field Controllers on the selected Site.

5. The relevant Field Controller option (UC32... orUCi16...) and Comms Controller option (UC32.net.. or
UCC4...) in the Instructions menu will now become active and it will be possible to set up the instructions
for the controllers.

6. The user can change target controllers and define new instructions for these controllers. This process
can be repeated until all tasks or instructions are defined.

These steps should be completed in this order or the Site Organizer will not work properly.
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Note:

CXproHP Site Organizer | Using the Site Organizer

Using the Site Organizer
THE PURPOSE OF THE SITE ORGANIZER

In order for the CXprotP system to operate, several types of 'Files' must be present on the system's
controllers. These files include:

e Setup files, describing the configuration of the system

e Strategy files, defining how controller outputs will react to controller inputs

e Keypad files, setting the way controllers will interact with attached keypads

e Schedule files, containing timing information for strategies

e Alarm files, listing the messages that controllers will send out when particular conditions arise in the
system.

...among others. The CXproHP Site Organizer is designed to help you to set up, maintain, and back up

files on Sites on a CXprotP network.

In order to use the Site Organizer, you must sign on, and then select the controllers that will be
configured.

Files can be downloaded to any combination of controllers or to one particular type of controller. Files
can be sent from the supervisor PC to the controllers on a Site, or they can be sent from controllers to the
supervisor PC.

The Site Organizer uses a 'batch' method, which means that to configure or analyze a Site you must:

e define a set of 'instructions', and then

e tell the Site Organizer to carry out the instructions in that set.

When the batch is run, all of the instructions are carried out, and the appropriate files are then sent to
their specified destinations.

The instructions can be edited before they are executed, and the number of controllers on each Site can
be altered. Dialog boxes are used to define the parameters for each instruction.

The Site Organizer can be used to make a backup of the files on a Site. Files from a Site, or an individual
controller, are transferred to and stored on a PC. They can then be restored to the Site at a later date, or
copied to a different Site.
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CXproHP Site Organizer | Using the Site Organizer

DOWNLOADING FILES TO CONTROLLERS

After you have selected the Commes Controllers and Field Controllers to which you want to send files, you
can then create a batch of instructions that will tell the Site Organizer which files are to be downloaded.

To download files you need to:

e Specify the Site to and controllers to which you want to download files, see
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CXproHP Site Organizer | Using the Site Organizer

e Choosing the controllers that will be affected by the actions of the Site Organizer on page 11

Set up a batch of instructions that will tell the Site Organizer which files are included in the download,
see Selecting the files that will be included in an upload or download on page 13

e Setthe ‘direction’ radio buttons at the top of each Instruction dialog to Download

@ Download 7 Upload

|I7 P S DR B [ 1

e Runtheinstruction batch, see
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Note:

CXproHP Site Organizer | Using the Site Organizer
®  RunningInstructions on page 17.

When you download a Strategy to a BACnet controller, any configuration that has been set by a
separate B-OWS - e.g. an Alarm Recipients list — will be wiped. You must re-download the Alarm Recipients list,
and any other B-OWS specific configuration after the Strategy download is complete.

UPLOADING FILES TO THE SUPERVISORY PC

You may want to upload files from the controllers on a Site to examine them on the supervisor PC.

The information that is uploaded from the controllers on a Site is placed into default files. As the
information is being uploaded, the Site Organizer will display the names of the files in which the
information is being placed. The newly created files can then be viewed in CXprotP.

You can use the Site Organizer to upload files from the controllers on a Site to the supervisor PC.

After you have selected the Comms Controller and Field Controllers that the program will target, you can
create a batch of instructions that will tell the Site Organizer which files to upload.

To upload files you need to:

e Select a Site, see Selecting a Site on page 11
e Select the controllers from which you want to upload files, see Selecting the controllers on page 11

e Set up a batch of instructions that will tell the Site Organizer which files are included in the upload,
see Selecting the files that will be included in an upload or download on page 13

e Set the ‘direction’ radio buttons at the top of each Instruction dialog to Upload

" Download Upload

|I— IR PT-ET T [ 1

e Runtheinstruction batch, see
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CXproHP Site Organizer | Using the Site Organizer

Running Instructions on page 17
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CXproHP Site Organizer | Using the Site Organizer

CHOOSING THE CONTROLLERS THAT WILL BE AFFECTED BY THE
ACTIONS OF THE siTe orRGANIZER

When you are using the Site Organizer you must specify the Site that you want to download files to, or
upload files from. When you have selected a Site, you must select the Comms Controller and Field
Controllers that are to be affected by the actions of the program.

One Site at a time can be configured using the Site Organizer.

SELECTING A SITE

To select the Site that you want to work on, either select Site from the Select menu, or click on the Site
button F@I in the Toolbar.

The Select Site dialog box will appear, displaying a list of the Sites in the system. Click on the one to be
selected.

e Click on the OK button to select the highlighted Site.

e  Click on the Cancel button to cancel the dialog box without selecting a Site.

SELECTING THE CONTROLLERS

After a Site has been selected, you must select the Commes Controllers and Field Controllers that will be
affected by the actions of the Site Organizer.

This cannot be done until the Site has been selected.
Select Targets... from the Select menu, or click on the Target button @l in the Toolbar.

The Select Targets dialog box will appear, displaying the name of the Site that has been chosen in the Select
Site dialog as Current Site name.
Select Targets
Current Site Mame

Comms Controller [Na Filler x| uclist  [WoFiter =]

ooz ucsz2-o0z

Select All Select All

Controller list

Controlle
add
Remove
Open
Save bs

Caneel

Selecting the Communications Controllers

The Comms Controller List (on the left hand side of the dialog) contains a list of the Communications
Controllers on the Site.

The list may be filtered to contain only certain types of Comms Controller, by using the options in the
drop-down list at the top of the list. If the No Filter option is selected, all Comms Controllers on the Site will
be listed.

Select the Comms Controllers to be targeted by clicking on them in the Comms Controller list. You can
select all of the Comms Controllers on the Site by clicking the Select All button.

©ABB 2020 All Rights Reserved.
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CXproHP Site Organizer | Using the Site Organizer

Selecting the Field Controllers
When you select a Commms Controller, the attached Field Controllers are displayed in the UC list.

The list may be filtered to contain only certain types of Field Controller, by using the options in the drop-
down list at the top of the UC list. If the No Filter option is selected, all Field Controllers attached to the

selected Comms Controllers will be listed.

Select the Field Controllers to be targeted from the UC list. You can select all of the Field Controllers on the
Site by clicking the Select All button.

When you click the Add button, the selected controllers are added to the Controller list.

Select Targets

Current Site Name:
Local Network.

Comms Contraller [Ho Fiter x| uClist  [NoFiter ]
001 CommsConfroller - 001
Select Al Select 4l
Contraller list
TommsCortoler - 001 FEEtEtD
CommsController - 007 : UC32 - 01
CommsController - 001 : UC32 - 02 Addt
Remave
Open
Save A
oK Cancel

If you want to remove a controller from the Controller list, highlight the controller in the list and click on the
Remove button.

Saving a Target list

It is possible to save the contents of the Controller list so that it can be quickly and easily recalled at a later
time. To save the Controller list, click the Save As button and specify a filename under which it will be saved.
Opening a saved target list

To recall a previously saved Controller list, click on the Open button, and select the filename under which the
list was saved.

©ABB 2020 All Rights Reserved.
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SELECTING THE FILES THAT WILL BE INCLUDED IN AN UPLOAD
OR DOWNLOAD

To download files to the controllers on a Site using the Site Organizer, you need to add instructions to
the batch specifying which files are to be downloaded to which controllers.

This is done by opening the Instructions dialog for the relevant controller type, configuring the required
download, and adding the instructions to the batch. The Instruction dialogs are opened from the Instruction

menu for

e UCC4-type communications controllers

e UC32.net/CBR-type communications controllers
e  UCxx/UCU-type Fieldbus controllers

e UC32/CBM/CBT-type Fieldbus controllers

THE ‘ASSOCIATED FILES’ OPTION

The CXproP system allows files to be “Associated” with specific controllers. For Comms Controllers, this
is done either through a configuration file as described below, and for Field Controllers, it is done through
the CXprof? interface (see MANO133 CXproHP for details).

For each file type within a Controller’s Instructions dialog, the Site Organizer can be set to upload either
the Associated file or a specified file. This is set from the individual instructions dialog for the ‘file’ within a
controller.

Using the Associated Files option saves time as it can be used to automate the selection of files that will be
added to a download.

UC32.net Instructions

& Downlr-- £t

E— UC32.net Keypad -
W Memory  wipe Meme Files J

o — & Azzociated
chas oo " Selected J
¥ Globaks Wwide In. e [ |
¥ Globals i |
¥ Globaks ] |
V¥ Schedule: Time Sche I:l J
¥ Keypad Keppad Pre J

E? _DK Cancel

¥ Setup Setup... - —I J
I~ Statistics Staistics... | IV Key PIN Keppad PIN |

Add To Batch | Carcel |

For example, in the UC32.net Keypad instruction dialog box shown above the Associated option has been
selected, which means that whichever Keypad file has been associated with the U32C.netK will be
included in the next download to that Comms Controller.

©ABB 2020 All Rights Reserved.
Subject to change without notice
WWW.CYLON.COM

13

MANO135 rev 3



Note:

CXproHP Site Organizer | Using the Site Organizer

HOW TO ASSOCIATE FILES WITH A COMMS CONTROLLER

Associations are created through the use of .Mak files. .Max files are text files (like . ini files) and can be
created in any editor.

Field Controller files (e.g. Strategy files) can be Associated using the CXprotD interface - see MANO133
CXprotD for details.
However, Comms Controller associations can only be defined manually.

.MaK files must be stored in the appropriate directory for each Comms Controller. Also, the filename must
reflect the first three letters of the Site directory name and the Comms Controller number.

For example, the . M2k file for Comms Controller number 1 on a Site called L.aNn would be stored in the
following path:

UnitronUC32\Lan\Dbase\1\LANOO1.MAK

The . M2k file for Comms Controller number 2 on on a Site called FAcTORY would be stored in the following
path:

UnitronUC32\FACTORY \Dbase\2\FAC002 .MAK

Example:  You decide that you want to create associations between Comms Controller number 3, on the

Note:

LAN Site, and certain specific files. You can use Notepad to create the file that will specify the
associations. For the Associated function to work, the file must be saved with the .mak
extension, and in the correct directory. With this in mind, you save the file as
UnitronUC32\Lan\Dbase\3\LANOO3.mak.

The Associated Files “Setup”

The Comms Controller associated files “Setup” is stored in the conrIG. TXT file with the other Site
configuration details (port config, alarms config and daylight saving.)

This file will not be present until Setup is sent (i.e. downloaded), using CXprotP, and uploaded in the Site
Organizer. This procedure must be performed by the user, as it is not carried out automatically by the
Site Organizer. The file will then appear in the following location: Unitronuc32\LAN\Dbase\1\Config. txt.

The config. txt file should not be edited, as any changes may cause CXprotP to function incorrectly.

©ABB 2020 All Rights Reserved.
Subject to change without notice
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CXproHP Site Organizer | Using the Site Organizer

COMMS CONTROLLER ‘ASSOCIATED FILES’ CONFIGURATION

For a Comms Controller, a . M2k file should be in the following format:

[UCC4]
DefaultName=
Globals=
Keypad=

DefaultName=

This is the filename to be used as a default if the Associated file cannot be found, e.g.
(PefaultName=UcCc4). It is not essential that you enter a default name. The name of the file defines the

controller with which the files specified below are to be associated.

Globals=

This entry specifies the name of the file containing Globals to be Associated with the Comms Controller.
The pathway and the extension are not specified here, just the name e.g.Globals=Global.

Keypad=

The same applies for the Keypad files (keypad=first) no pathway or extension.

Sample

[UCC4]
DefaultName=UCC4
Globals=Global
Keypad=first

©ABB 2020 All Rights Reserved.
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AUTOMATICALLY UPDATING THE ASSOCIATIONS BETWEEN FILES AND
CONTROLLERS

To automatically update the associations between files and controllers, select Options... from the Select
menu to open the Options dialog:

—Ermor Level

" Stop on batch smor

&% A amning message on batch ermror

— Databaze Aszociations
' Mo updates
¢ Commit all updates

i |ndividually acknowledge updates

— Undo Feature
& |Undo Disabled
™ Undo Enabled

] I Cahcel

The Database Associations section of the dialog updates the associations between controllers and
specific files through the use of the associated function.

Information about associations between a controller and specific files is contained in an associated
(.mak) file. If you download a file to a controller that is different to the file specified in the associated file,
the Database can be updated so that the new file you have selected will become the default associated
file for that controller. For more information, see page 13.

No Updates
If you select this option, the Database will not be updated.

Commit All Updates
The Database Interface will be updated automatically.

Individually acknowledge updates
The Database will not be updated automatically. A Message box will appear giving the user the choice as
to whether to update the Database or not.

©ABB 2020 All Rights Reserved.
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RUNNING INSTRUCTIONS

To execute the instructions contained in the batch, click on the Run button J. in the Toolbar, or select
Run/Complete Batch from the File Menu.

Actiong

. i omplete Batch  Cirl+R

E Reset Batch

You will be asked to confirm before running:

@ Are pou sure you want ta run these instruchions 7

: Cancel |

After you click the OK button, the Instructions Window will open to display the progress of the batch:

i Instruction Window %]
= HO Memnary_Wipe : * — [H] Rooftop:
o H1 Setup : config txt — [H] Rooftop Print List |
w® #2 Cun_Time: * — s [H] Rooftop:
h® #3 Site_Mumber: * — = [H] Rooftop

Stop |

— Repart Log
Runting ... -
Uniitled Batch File Start - 12:12 17/05/00
Sitenarne Local Metwork Clear Beportl
#0 Download UCCA Memaory wipe
Raonftop :

Downloaded 1 Blocks

#1 Download UCC4 Seb
R ogﬁ\lonpo:a e Print Repart |

Downloaded 1 Blocks ;I

Bl LA el i
Cloge |

While the Instructions are running the Status Bar will display the block numbers being sent and the
percentage of the completed batch.

Block : 15 0 | 14

When the instructions are running, the Undo button will change to a Stop button and when they are
finished the button will change back to the Undo button.

If any incomplete instructions remain when the batch has been run, click again on the Run button to re-
run the batch.

©ABB 2020 All Rights Reserved.
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EDITING THE INSTRUCTIONS BATCH

Once a batch of instructions has been set up it is possible to view and edit them before they are run and
sent as a batch to the Site.

Select Instructions/Target Window from the View Menu to open the Instructions dialog. This lists the
instructions contained in the batch.

i Ingtructions |
— Inztuctions

[nztruction : #0 -

Function : Download
Contraller : Rooftop AHLIN Edit I
Type : Memony \wWipe

Inztruction : #1
Function ;: Download
Contraller : Rooftop AHU 1
Type : Analog_Pt Delete I
Fange : 1-285
Default : On
Selfile
Azeoc: On
[nztruction ;: #2
Function : Download
Contraller : Rooftop AHL 1
Type : Digital_Pt
FRange : 1-256
Default : On
Selfile : cvan3000wEN an'strat B strategyd. st
Azzoc : OFf

[nztruction : #3 -
Linehon s Maload
4 l F

The Instructions list box contains the instructions to be sent to the Site. For each instruction you can see
the instruction number, whether it is an upload or download, the target controller, the command type
and the parameters that have been configured.

Editing the Instructions in the batch

You can edit any of the instructions in the list. To do this, select an instruction in the list and click on the
Edit button. The dialog box for that instruction type will be displayed, allowing the parameters for the
selected instruction to be edited.

Removing an instruction from the batch

To remove an instruction, select it in the list and click the Delete button.

©ABB 2020 All Rights Reserved.
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CXproHP Site Organizer | Using the Site Organizer

ERROR HANDLING

You can configure the way that the Site Organizer will react if an error occurs when instructions are being
carried out.

To set the way the Site Organizer will react to an error, select Options from the Select menu to open the
Options dialog.

The Error Level section of the dialog determines how the program will react if an error occurs when a
batch of instructions is being executed.

Error Level

£~ Stop on batch emor

& M/aming message on batch emror

If the Stop on batch error option is selected, the program will stop executing the instructions in the current
batch if an error occurs during an upload or download.

If the Warning message on error option is selected, a warning message will appear on screen when an error
occurs during an upload or download. For example:

#2 Download UC16 Modem

Warehouse : UCXX - 001
Unable To Load File \UnitronUC32\lan\modem\di@®02001.mos - 26 Blocks

Downloaded © Blocks

©ABB 2020 All Rights Reserved.
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VIEWING THE REPORT LOG

The Report Log shows the progress of running an instruction batch file, as files are downloaded or
uploaded.

Select Association/Run Window from the View menu.

This opens a dialog that contains two windows — the lower window shows the Report Log, and the upper
window shows either the Association Window :

: Association Window
I Fooitop
[H Rooftop - AHU 1 Prirk List
Al Rooftop - 4HU 2
[t
Report Log
Funning .. -
Untitied Batch File Start - 12:12 17/05/00
Siterame Local Network. Dlear Beport
H#0 Dawnload UCCH Memany ‘wipe
Rooftop
Downloaded 1 Blocks
#1 Download UCCA Set
HDS,?;DN b Prirt Report
Downloaded 1 Blocks LI
Close
or the Instruction Window:
} Instruction Window [x]
[7 50 Memon_wipe - —_ [ Rooftop
I H#1 Setup - config txt [§ — Hl Rooftop Prirk List
? #2 Cumr_Time: ® —— [Hl Rocftop:
g #3 Site_Mumber: = — M Rooftap:
Undo
Report Log
Funning -
Untitled Batch File Start - 1212 17/06/00
Sitename Local Network Clear Bepart
#0 Download UCC4 Memany_Wipe
Rooftap @
Downloaded 1 Blocks
#1 Download UCCH Seb
Hooofutvonpo:a e Print Repart
rloaded 1 Blocks LI
APl d IR A P T
LCloze
The Association Window shows a diagram of the path to the Comms Controller and Field Controllers on the

Site.

The Instruction Window shows the progress of the Instruction batch.

The dialog has a number of buttons:

Print List : This prints the association list, showing the associations between controllers and specific files.

Instructions / Associations This is a toggle button that switches between the Instructions Window and the Association
Window .

Clear Report This clears the Report Log window.

Print Report : this prints the contents of the Report Log window.

©ABB 2020 All Rights Reserved.
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SAVING AN INSTRUCTION BATCH

After you have created an instruction batch file, it can be saved and stored for later use, or it can be used
on another Site.

Select Save from the File menu or click on the Save button El in the Toolbar.

If the file has not been saved before, the Save As dialog box will appear. Specify the filename and location
for the saved file.

Files will be saved in .ins format.

If the file has been saved before, the existing file will be overwritten with the same name.

OPENING A PREVIOUSLY SAVED INSTRUCTION BATCH

You can open a previously saved instruction batch.
Select Open from the File menu or click on the Open button @l in the Toolbar.

The Open dialog box will appear, displaying existing files of .ins types. Navigate to the location of the
previously saved batch.

CREATING A NEW FILE
You can close and save the instruction batch that you are working on at any time and begin creating a
new batch.

Select New from the File menu or click on the New button [ | in the Toolbar.

The option will be given to save the current batch of instructions before the new document appears.
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Note:

BACKING UP INFORMATION FROM A SITE

If you are planning on making any changes to a Site, but want to have the option of restoring the original
settings, you can make a copy of the information that is currently stored on the controllers and store it
on the supervisory PC. This is also useful for recovery if information on a controller is corrupted.

A back up of a Site or controller can be created through the use of the Site Organizer - the program will
automatically create a batch file that contains the instructions required to upload all the information
from a Site or controller. When the instructions in the file are executed, a backup of information from the

Site is created.
To back up information from a Site

e  Select the Backup option from the Select Menu.
e Select the Site or section of a Site that you want to back up.

The item selected in the Site List determines how the backup will proceed. If you select a Comms
Controller or Field Controller in the list, only the information relevant to that device will be uploaded. If
you select a Site, the information for all of the attached devices will be uploaded.

e  Click the Start Backup button.

e Click the OK button to run the instructions that will create a backup - the Instruction Window will open,
showing you the progress of the backup process.

+ Instruction Window E
o? HO Memony ‘wipe : * —— [H] Rooftop :
s H1 Setup : config. bt — [HI Rooftop : Pririt List |
w? #2  Cum_Time: * — [H] Rooftop:
” #3 Site_Mumber: * —— [H] Rocftap
Unda |
Fepart Log
Running ... -
Untitled Batch File Start - 12:12 17/05/00
Sitename Local Metwark Clear BEDU'tl
#0 Download UCC4 Memary_wWipe
Fooftop :
Downloaded 1 Blocks
#1 Download UCC4 Setu
Rooftap : i Erint HEDUTtl
Downloaded 1 Blocks LI

Lloze |
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Note:

RESTORING INFORMATION TO A SITE

Information that has been backed up from a Site or controller can be restored through the use of the Site
Organizer - the program will automatically create a batch file that contains the instructions required to
download all the information to a Site or controller. When the instructions in the file are executed,
information is restored to a Site or controller.

To restore information to a Site

e  Select the Restore option from the Select Menu.

e Select the Site or section of a Site that you want to restore.

The item selected in the Site List determines how the restoring will proceed. If you select a Comms
Controller or Field Controller in the list, only the information relevant to that device will be restored. If
you select a Site, the information for all of the attached devices will be restored.

e  Click the Start Restore button

e Click the OK button to run the instructions to restore information - the Instruction Window will open,
showing you the progress of the restore process.

i Instruction Window
= B0 Memany_Wipe : * — [H] Rooftop:
= H#1 Setup ; config.tat —— [H] Raocftop: Pririt List |
= #2 Cun_Time: * — [H] Rooftop
= #2  Site_Mumber: * —— [H] Racftop:

Undo |

—Report Log

Fiunning ... -

Urtitled B atch File Start - 12:12 17/06/00
Sitename Local Metwork Clear EEDmtl

H#0 Download UCC4 Memomn_wWipe
Rooftop
Downloaded 1 Blocks

#1 Download UCC4 Setuy
Raoftop: : FPrint Report |

Downloaded 1 Blocks ;I

O el m IO A e Timen
LCloze I
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PRINTING INFORMATION FROM THE siTE ORGANIZER

The following information can be printed from the Site Organizer:

e The content of the Instruction Window

e The content of the Association Window

e Uploaded Statistics

e The content of the Report Log window.

Select Print Setup from the File menu or choose the Printer button from the Toolbar.
Altering the Printer Setup

Select Print Setup from the File menu. The generic Print Setup dialog box will appear.
The named printer and other parameters can then be altered.

Altering the Page Setup

Select Page Setup from the File menu.

The Page Setup dialog box will appear. This allows you to set the page margins for Site Organizer
printouts.

PogeSowp |
— Maraing [cm]
-
Bight 1.7

Top I‘I_? Cancel |
Bottom I-I-?
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CXproHDP Site Organizer | Comms Controller Instructions

Comms Controller Instructions
INTRODUCTION

Instructions are set up for the Communications Controllers on the Site using either the UC32.net Instructions
panel or the UCC4 Instructions panel. To open the relevant panel, select either UC32.net... or UCC4... from the
Instructions menu or click the .net or UCC4 button in the Toolbar.

The Comms Controller Instructions panel allows access to different Instructions depending on the load
direction (Download or Upload) and controller type:

UC32.net Instructions UC32.net Instructions
 Download ¢ Upload " Download ¢ Upload
W Memory  Wipe Memory...l v Alarms Maodem... | [T Memory  Wwipe Memnl_l,l...l v Alarms todem. . |
v Globals Local... | v Alarms Prinker... | [T Globals Local... | v Alarms Prirter... |
v Globals Wwide In... | v Alarms PC... | [T Globals wide ... | v Alarms PC... |
v Globals wide Out... | v Alarms Configure... | ™ Globals dide Out. . | v Alarms Configure... |
v Globals Smart... | V¥ Port Configure... | ™ Globals Srnart... | v Part Configure... |
¥ Scheduls:  Time Sched... | ¥ Time Time... | W Scheduls:s  Time Sched... | [T Time Time... |
¥ Keypad  Keypad F'ng...l v Daylight Saving... | ¥ FKeypad  Keypad Png---l v Daylight Saving... |
W Setup Setup... | W Site Mo, Site Mo... | W Setup Setup. | I Site No. Site Mo... |
[T Statistics Statistics... | ¥ FeyPIN Keypad PIM | ¥ Statistics Statistics... | v KeyPIN Keypad PIN |
Add To Batchl Cancel I Add Ta Batchl Canicel I
UCC4 Instructions UCC4 Instructions
" Download ¢ Upload " Download ¢ Upload
¥ Memary  ‘wipe Memory..| > M.B. Modem stings also wiped [T Memory wipe Memon|-> M.B. Modem stings also wiped
v Glabals Local... V¥ &lams Modem... [T Globals Local... v lams Modem...
v Globals wide ... W alams Frinter... [T Globalz Wide In... v Alarms Printer...

e
[

4410

¥ Globals wide Q... W alams [T Globalz Wwide Olut... v Alams
v Globals Smart... v &larms Configure... [T Globalz Smart... v &lams Configure...
W Schedule: Time Sched.. | v Pot Configure... ¥ Schedule: Time Sched.. | W Port Configure. ..

v FKeypad Kewpad Prog..| W Time Time... V¥ Keypad Keypad Prog...| [ Time Time...

FRRLLELL
ELRRERE

¥ Setup Setup... v Daylight Saving... v Setup Setup... ¥ Daylight Sawing...
[ Statistics Statistics. . v Site No. Site Mo, [ Statistics Statistics... | [T Site Mo Site M.

Add To Batchl Cancel I Add To Batchl Cancel I

i

The UC32.net Instructions panel includes KeyPad Pin, which UCC4 Instructions panel does not.
When Download direction is selected, the Statistics Instruction is not available.

When Upload direction is selected, the Statistics Instruction is available, but the Memory, Time, Site No. and
the four Globals Instructions are not.
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CXproHP Site Organizer | Comms Controller Instructions

BUTTONS AND CHECKBOXES

Download / Upload radio buttons

Selects whether information will be downloaded from the PC to the controllers or uploaded from the
controllers to the Supervisory PC.

Instruction Checkboxes

If the checkbox beside an Instruction is ticked, then that Instruction will be added to the Batch, and the
latest configuration for that Instruction will be applied. If the box beside an Instruction is cleared, that
Instruction will not be included in the Batch the next time it is run.

Instruction Buttons
Clicking the Button for an Instruction allows that Instruction to be configured.

Add To Batch

Clicking this button adds the configuration of the Instructions panel - the selected Instructions and the
parameters set for each one - to the Batch that will be run when Run/Complete Batch is selected from the
Actions menu (see
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CXproHP Site Organizer | Comms Controller Instructions

Running Instructions on page 17).

Cancel
Closes the panel without altering the Batch.
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CXproHDP Site Organizer | Comms Controller Instructions

INSTRUCTIONS
MEMORY WIPE

To wipe the Comms Controller’'s memory when a batch is run before any of the other instructions in the
batch are downloaded, tick the Wipe Memory checkbox on the Comms Controller Instruction panel.

Note: If you wipe the memory of a Comms Controller that is connected to the PC via a modem, this will cause

the modem strings to be wiped from the Comms Controller’'s memory. This means that you will have
to download the modem strings to the Comms Controller again.

No configuration is required for Memory Wipe. Clicking the Wipe Memory button displays an information
box:

UC32.net Memory Wipe

LUC32 net Memon 'Wipe

ak I Canhicel

Press OK or Cancel to close the box.

TIME SCHEDULE

Toinclude Time Schedules in the instructions batch, tick the Schedules checkbox on the Comms Controller
Instructions panel.

No configuration is required for Time Schedule instructions. Clicking the Time Sched... button displays an
information box:

UC32.net Time Schedule

C32 net Time Schedule

(] I Cancel

Press OK or Cancel to close the box.
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Note:

CXproHDP Site Organizer | Comms Controller Instructions

GLOBALS

There are 4 separate types of Globals that can be included in an Instructions Batch: Local, Wide In, Wide
Out and Smart.

v Globals Local... |
v Globals Wide In... |
W Globals  ‘wide Out... |
v Globals Smart... |

To include or exclude any of these types of Globals to the Instruction Batch, tick or clear the checkbox
next to each of Globals Local, Globals Wide In, Globals Wide Out or Globals Smart.

To configure the Globals that will be included in the Instruction Batch, click on the relevant button.

The dialog that will open for any of the Globals types will contain the same parameters:

— Files todule Range
% Aszociated & Default
™ Selected " Selected

Fie | Range 164

[~ wipe Memory

Cancel |
Files

If Associated is selected then each Comms Controller’'s Associated file (see page 13) will be used.

If Selected is selected then the Open dialog will be displayed to allow you to select a specific Globals file to
send to all Comms Controllers on the Site. This will have the extension . cmn.

The File box will show the name of the selected file.
Module Range
If Default is selected then all the Local Globals will be included.

If Selected is chosen then a range of Local Globals to be included can be specified in the Range box. Values
between 1 and 255 may be entered for Local Globals, and values between 1 and 64 for Wide In, Wide Out
and Smart Globals.

It is possible to specify several ranges of globals suchas 1,12,16-20, 44,
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CXproHDP Site Organizer | Comms Controller Instructions

KEYPAD PROGRAM
Clicking on the Keypad Program button in the Comms Controller Instructions dialog box opens the Keypad
dialog.

UC32.net Keypad

— Files

i Azzociated
% Automatic

Fle |

[ “wipe Memaony

] I Cancel

Files
If Associated is selected, then each Comms Controller’s Associated file (see page 13) will be used.

If Download is set as the Batch direction, then there will be a Selected option. If Upload is selected there will
be an Automatic option.

If Selected is chosen during Download, then the Open dialog will be displayed to allow you to select a
specific Keypad Program file to send to all Comms Controllers on the Site. This will have the extension

.kp4.

The File box will show the name of the selected file.

If Automatic is selected during Upload, then the Keypad information received from the CXprotP Site will be
stored in files automatically created by the Site Organizer.

Wipe Memory

This option is disabled if Upload direction is selected

If this box is selected, the keypad program on each Comms Controller will be wiped before the new
keypad program is downloaded.
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Note:

CXproHP Site Organizer | Comms Controller Instructions

SETUP

To include the controller Setup information in the instructions batch, tick the Setup checkbox on the
Comms Controller Instructions panel.

Clicking on the Setup button in the Comms Controller Instructions dialog box opens the Setup dialog.

The parameters in this dialog can only be edited in Download mode, and only if the Associated file
checkbox is not ticked.

The controller “Setup” is basic configuration that is stored on the controller.

UC32.net Setup
- File I Update File
¥ Associated Uzer 1D I_

— Compozed

Time I Date I

— Metwork Information

JE16s on subnet
Local Globals

Wide Input Globals
Wide Output Globals

E ST

UCC4s on Archet

] I Cancel |

Files

If Associated is selected then each Comms Controller’s Associated file (see page 13) will be used, and the
parameters of the Setup dialog will not be editable.

Composed

This is a Date and Time that will be stored in the controller. It is normally used to represent the time at
which the Setup was downloaded to the controller.

Update File

If this option is checked, then the config.txt file on the PC will be kept in sync with the values on the
controller.

User ID
This contains the User ID.

Network Information

These parameters tell the Controller how many Field Controllers Local Globals, Wide Input Globals, Wide
Output Globals and Comms Controllers it must interact with on both its Fieldbus and the “Unet”.
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STATISTICS

Note: This is only available in Upload Mode.

When this instruction is run as part of a batch, a report is generated that is stored in a file and may also
be printed out on the current printer. The report is stored as a .csv (comma-separated value) file. It is
saved in the \Unitronuc32\LAN\Archive directory. The filename used for the report is displayed in the
Report Log when the Instruction is run.

UC32.net Statistical Report

[ Include ¥ ‘“wipe Statistics
v Setup ¥ Send Tao Printer
W Wersion * Create new file
[ System Stats " Append ta file

¥ Engineering Stats
¥ Arcnet Stats

Cancel |

Setup
If the Setup box is ticked, the Setup statistics will appear in the report. For example:
Sitename Local Network
ID #001
Rooftop
Time 11:53 27/06/00

Advanced Setup

Composed 10:30 27/06/00
User ID 0
UC16s 1
Local Globals 0
Wide In Globals 0

Wide Out Globals 0

UC32.nets 0

Version

If the Version box is ticked, the Comms Controller’s version number will appear in the report. For example:

Version UC32.net 3.6.7b
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CXproHDP Site Organizer | Comms Controller Instructions

System Statistics

If the System Statistics box is ticked, System Statistics will appear in the report. For example:

System Stats

Last Reset 11:5910/6/00

No. Alarms 0

Last Power Down 11:20 09/6/00
Last Power Up 11:5010/6/00

Engineering Statistics

If the Engineering Statistics box is ticked, the Engineering statistics will appear in the report. For example:

Engine. Stats

No. Resets 0
Subnet Errors 0
UC32.net Servicing X
Port Check X
Setup Check X
Locals Check X
Wide In Check X
Wide Out Check X
Time Sched Check X
Day Save Check X
Alm Level Check X

Unet Statistics

The Unet statistics will appear in the report. For example:

Unet Stats

Total Reconfig 0
Local Reconfig 0
Excessive Nacks 0
Status 0
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CXproHP Site Organizer | Comms Controller Instructions

Wipe Statistics

If this checkbox is ticked, the Statistics will be wiped from the Controller memory after saving/printing.
Send to Printer
If this box is checked, the report will be printed out on the current printer.

If this box is cleared, the report will not be printed.

Create File

If this checkbox is ticked, the statistics will be saved to a new file

Append to file

If this checkbox is ticked, the statistics will be added to an existing file
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CXproHP Site Organizer | Comms Controller Instructions

ALARM STRINGS

Alarm strings for Modems, Printer and PC can be included in the Instructions batch. They all have the
same configurable parameters:

— String Range

f* Default
" Selected

Fange |1 -100

[ wipe Memary

ak. Cancel

Modem Strings

Modem alarm strings are used to configure a modem that is directly connected to a Comms Controller.
The strings, which are used to signal modem activity, are configured using the Cylon® Dial-Out
Configuration program. The strings that can be configured are the Password string, the Initialisation
string, the Dial out string, the Disconnect string and the Connect string.

Printer Strings

This allows you to download strings that are used to customize the format of alarm messages. Thirteen
strings are available, and these can be edited using the Cylon® Dial-Out Configuration program.

String Range

If Default Is selected then all of the Comms Controller’s Alarm Strings will be transferred.

If Selected is chosen then only the Alarm strings in the specified range will be transferred. Values between
1and 100 may be entered.

Wipe Memory

If this checkbox is ticked the previous modem strings on the Comms Controller will be wiped before the
new strings are downloaded.
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Note:

CXproHDP Site Organizer | Comms Controller Instructions

ALARMS CONFIGURATION

The parameters in this dialog can only be edited in Download mode, and only if the Associated file
checkbox is not ticked.

Clicking on the Alarms Configure button in the Comms Controller Instructions panel box opens the Comms
Controller Configure Alarms dialog.

UC32.net Configure Alarms

— Port Humber—— Lowwer Limnit Ilpper Limit

o Band1 1 2565
e2 Band2 11 255
e 3 Band3 11 255

I Update File V¥ Accept Spstem Slarms
—File

[T Azzociated ok, I Caricel

This allows you to filter alarms through different ports, or to send alarms through multiple ports.

File
If Associated Is selected then each Comms Controller’'s Associated file (see page 13) will be used, and the
parameters of the Setup dialog will not be editable.

Port Number and Band

Comms Controllers can have up to 3 ports onto which modems can be connected. For each of these
ports up to 3 ranges of Alarm priorities can be assigned.

Select each Port Number in turn and for each one set up to 3 different ranges of priorities with values for
both Lower Limit and Upper Limit between 1 and 255.

Accept System Alarms

When checked, Alarms reflecting the operation of the Cylon® system (in addition to those reflecting the
values of points within a Field Controller Strategy) will be processed.

Update File

If this option is checked, then the config. txt file on the PC will be kept in sync with the values on the
controller.
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CXproHDP Site Organizer | Comms Controller Instructions

CONFIGURING THE UC32.NET PORTS

Clicking on the Port Configure button in the Comms Controller Instruction panel opens the Comms Controller
Port Setup dialog box.

UC32.net Port Setup
Port 1 | Port 2(USE) | Port 3 | Port 4 (Modbus) |

— Setup

Baud Im

[T Update File  |v Assoc File 0K I Cancel

Comms Controller Ports can be configured through this dialog, but are more normally configured in
CXproD. The parameters are identical to the equivalent dialog in CXprotP — see MANO133 CXproHb
manual, for more detail.

If Assoc File is selected then each Comms Controller’s Associated file (see page 13) will be used, and the
parameters of this dialog will not be editable.

If the Update File checkbox is ticked, then the config.txt file on the PC will be kept in sync with the values
on the controller.

TIME

Clicking on the Time button in the Comms Controller Instruction panel opens the Comms Controller
Curr_Time dialog.

UC32.net Curr_Time

Tirme Date

[10:33:14 |28/0715

v Cumert PC Time

| (1] I Cancel

If the Current PC Timecheckbox is ticked, the current time set on the Supervisory PC will be sent. If it is
cleared, then values can be entered for the Time and Date.
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CXproHDP Site Organizer | Comms Controller Instructions

DAYLIGHT SAVING

Clicking on the Daylight Saving... button in the Commms Controller Instruction panel opens the Comms
Controller Daylight Saving dialog.

UC32.net Daylight Saving

File——— Setting

[T Associated i+ None
i EU
[ Update File ous

] | Cancel

File
If Associated is selected then each Comms Controller’'s Associated file (see page 13) will be used, and other
parameters in this dialog will not be editable.

Setting

None: The set time will be used, and will not be adjusted automatically at different times of the year.
EU: Time will be adjusted according to EU daylight-savings algorithm.

US: Time will be adjusted according to US daylight-savings algorithm.

Update File

If this option is checked, then the config.txt file on the PC will be kept in sync with the values on the
controller.

SITE NUMBER

Clicking on the Site No... button in the Commms Controller Instruction panel opens the Comms Controller Site
Number dialog.

UC32.net Site Number

Site Mumber

[1]
| ()4 I Cancel |

Site numbers are automatically assigned in CXprot? but can be edited here if required.
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CXproHD Site Organizer | Comms Controller Instructions

KEYPAD PIN
Clicking on the Keypad PIN... button in the Comms Controller Instruction panel opens the Comms Controller
Keypad PIN dialog.

UC32.net Keypad PIN

W Enable Keypad Configuration Menus

— Select at least 4 arow keys (U.DLR]

RILIEIEIEAEIEIEArd

— File

[T Azsociate [T Update

Cancel |

File
If Associate is selected then each Comms Controller’s Associated file (see page 13) will be used, and other
parameters in this dialog will not be editable.

If Update is selected, then the config.txt file on the PC will be kept in sync with the values on the controller.

Enable Keypad Configuration Menu

If this is ticked, then the Configuration option on the keypad will be enabled — users will be able to
configure the Comms Controller from the keypad.

Select at least 4 arrow keys

Clicking in each of the boxes in this section of the dialog cycles through an up arrow, down arrow, left
arrow or right arrow. When downloaded to the controller, the sequence of arrows will be the sequence
required as a password to enter the Configuration Menu on the keypad.
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4

CXproHP Site Organizer | Field Controller Instructions

Field Controller Instructions
INTRODUCTION

Instructions are set up for the Field Controllers on the Site using either the UC32 Instructions panel or the
UC16 Instructions panel. To open the relevant panel, select either UC32 ... or UC16... from the Instructions
menu or click the .net or UCC4 button in the Toolbar.

The Comms Controller Instructions panel allows access to different Instructions depending on the load
direction (Download or Upload):

" Download © Upload

)

Download Upload

v Memory  wipe Memany... [T Memoy  Wipe Memory...l
v Keypad KeypadProg... ¥ Keypad Keppad Prog...l
v Setp Setup... ¥ Setup Setup... |
v todem Settings... ¥ Modem Settings... |
¥ Time Time... [~ Time Tirne... |
W Paints Analog... ¥ Points Analog... |
W Paints Digital... ¥ Points Digital... |
[V Strategy  Strategy.. ¥ Shategy  Strategy... |
[T Statistics | Statistics... [¥ Statistice  Stakistics... |

Add To Eatchl Add Ta Batchl

Cancel | Cancel |

When Download direction is selected, the Statistics Instruction is not available.

d1Lald

When Upload direction is selected, the Statistics Instruction is available, but the Memory, and Time
Instructions are not.

BUTTONS AND CHECKBOXES

Download / Upload radio buttons

Selects whether information will be downloaded from the PC to the controllers or uploaded from the
controllers to the Supervisory PC.

Instruction Checkboxes

If the checkbox beside an Instruction is ticked, then that instruction can be added to the Batch.

Instruction Buttons
Clicking the button for an Instruction allows that Instruction to be configured.

Add To Batch

Clicking this button adds the configuration of the Instructions panel - the selected Instructions and the
parameters set for each one - to the Batch that will be run when Run/Complete Batch is selected from the
Actions menu (see

©ABB 2020 All Rights Reserved.
Subject to change without notice
WWW.CYLON.COM 40

MANO135 rev 3



CXproHP Site Organizer | Field Controller Instructions

Running Instructions on page 17).

Cancel
Closes the panel without altering the Batch.

INSTRUCTIONS
MEMORY WIPE

To wipe the Field Controller’'s memory when a batch is run before any of the other instructions in the
batch are downloaded, tick the Wipe Memory checkbox on the Field Controller Instruction panel.

No configuration is required for UC16 Memory Wipe. If the UC16 Instructions panel is being used, clicking
the Wipe Memory button displays an information box:

UC16 Memory Wipe

LUC1E Memorny Wipe

(0] I Cancel

Press OK or Cancel to close the box.

If the UC32 panel is being used, clicking the Wipe Memory button displays a dialog box allowing parts of
the Field Controller’'s memory to be wiped:

Wipe UC32

¥ “wipe Strategy

¥ wipe Points

¥ “wipe Modem Stings
¥ “wipe Keypad

¥ “wipe Globals

¥ “wipe Schedules

¥ “wipe Configuration
v wipe UC32 Memary

(] I Cancel

Selecting Wipe UC32 Memory will automatically select all parts of the memory to be wiped. Clearing this
checkbox will allow any of the other checkboxes to be cleared.

Press OK to save the current configuration to the batch, or Cancel to close the box without changing the
Wipe Memory configuration.
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KEYPAD PROGRAM

Clicking on the Keypad Program button in the Comms Controller Instructions dialog box opens the Keypad

dialog.
Download Upload
UC32 Keypad UC32 Keypad
Files Files
* Aszsociated " Aszociated
 Selected * Automatic
File I File I
0K I Cancel | oK I Cancel |
UC16 Keypad UC16 Keypad
— File= —Files
0 Associated " Associated
" Selected & Automatic
File I File I
[ Wipe Memary [ wipe Memony
" Serial & Parallel
0k I Cancel (] I Cancel
Files

If Associated is selected then each Field Controller’s Associated file (see page 13) will be used.

If Download is set as the Batch direction, then there will be a Selected option. If Upload is selected there will
be an Automatic option.

If Selected is chosen during Download, then the Open dialog will be displayed to allow you to select a
specific Keypad Program file to send to all Field Controllers on the Site. This will have the extension . kp4.

The File box will show the name of the selected file.

If Automatic is selected during Upload, then the Keypad information received from the Cylon® Site will be
stored in files automatically created by the Site Organizer.

Wipe Memory (UC16 only)
This option is disabled if Upload direction is selected

If this box is selected, the keypad program on each Field Controller will be wiped before the new keypad
program is downloaded.

Serial / Parallel (UC16 only)

This sets whether a Parallel or Serial keypad program will be sent.
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SETUP

To include the controller Setup information in the instructions batch, tick the Setup checkbox on the Field

Controller Instructions panel.

The controller Setup is basic configuration information stored in a controller, indicating how many

Strategy modules it should expect to service, how quickly it should service them etc., along with some

information useful to an Engineer configuring the Site.

Clicking on the Setup button in the Field Controller Instructions dialog box opens the Setup dialog.

Note: The parameters in this dialog can only be edited in Download mode, and only if the Associated file
checkbox is not ticked.
The controller “Setup” is basic configuration that is stored on the controller.
UC32 Setup UC16 Setup
~File ~Mo. Modules Mo, Modules File
[ Associated IEI ID_ ’]- Agzociated
— Composed — Last Modified — Compozed
Time [16:27:04  Date |28/07/15 Time [16:27:04  Date |28/07/15 Tt |1 B28 Date |28£D?‘£1 ]
User D ID_ dser Hame I User ID IU_
Strategy 1D IEI_ Drawing Fef. I Strateqy ID ID_
Min Service Time ID_ Min Service Time ID_
Time Synch w/ait After Fiesst ID_ Time Synch 'Wait &fter Feset ID_
ok | Cancel oK | Cancel |
File
If Associated is selected then each Comms Controller’s Associated file (see page 13) will be used, and the
parameters of the Setup dialog will not be editable.
No. Modules
This should be set to the number of modules used in the Field Controller’s Strategy.
Composed
This is a field where you can record the Time and Date at which this Setup information was originally
entered.
Last Modified (UC32 only)
This is a field where you can record the Time and Date at which this Setup information was last modified.
User ID
A number can be entered here to identify the engineer who composed the Setup block.
©ABB 2020 All Rights Reserved.
Subject to change without notice
43

WWW.CYLON.COM

MANO135 rev 3



CXproHP Site Organizer | Field Controller Instructions

User Name (UC32 only)

An arbitrary string can be entered here to identify the engineer who composed the Setup block.

Strategy ID

A number can be entered here to identify the Strategy used by the Field Controller. This can be used to give
an indication of the function that the Controller will perform. The number entered here should match the
ID defined in CXprotP for the Strategy held by the Controller.

Drawing Ref (UC32 only)

An arbitrary string can be entered here to identify the Strategy drawing used in CXproHP when creating
the strategy in the Controller.

Min Service Time

The number entered here defines the interval, in seconds, at which the Controller will service the Strategy.
This feature is useful for time-sensitive operations.

Time Synch Wait After Reset

This is the time (in seconds) after a reset for which the Field Controller will wait for a time synchronizing
communication from the Comms Controller before starting to service the Strategy. If the Field Controller
receives a time synchronizing pulse, it will start to service the Strategy immediately. If not, the Field
Controller will wait for the number of seconds specified here to elapse and then start servicing the

Strategy.
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MODEM SETTINGS
Clicking on the Settings button beside Modems in the Field Controller Instructions dialog box opens the
Modem dialog.

—Files
o Associated

[ wWipe Memony

(] I Cancel

Files
If Associated is selected then each Field Controller's Associated file (see page 13) will be used.

Wipe Memory
This option is disabled if Upload direction is selected

If this box is selected, the keypad program on each Field Controller will be wiped before the new keypad
program is downloaded.

TIME
Clicking on the Time button in the Field Controller Instruction panel opens the Field Controller Curr_Time
dialog.

UC32 Curr_Time

Tinne Date

|16:44:51 |28/07415

v Current PC Time

| Ok I Cancel

If the Current PC Timecheckbox is ticked, the current time set on the Supervisory PC will be sent. If it is
cleared, then values can be entered for the Time and Date.
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POINTS - ANALOG... AND DIGITAL...

The Site Organizer can set the values of points in a Field Controller (download), or record their current
values (upload). The Analog Points dialog defines the points within the Field Controller whose values are to
be set or recorded, and the file where the values are stored.

The relevant Points dialog is opened by pressing either the Analog... button or the Digital... button on the
Field Controller Instructions panel.

Download Upload
UC32 Analog Points UC32 Digital Points UC32 Analog Points UC32 Digital Points
# Associated @ Associated  Associated ) Associated
 Selected © Selected  Automatic @ Automatic
File File File T
- Wirtual Rang: [~ Wirtual Rang Vitual Range———————————————————— ~Vitual Range:
& Default & Default @ Defauit @ Default
© Selested ©* Selected € Selected € Selected
Yirtual Points Range 1-1024 Wirtual Points Fiange 1-1024 “irtual Points Fange 11024 Wirtual Paints Flangs 11024
- Hardware Range—————————————————————— [~ Hardware Range [ Hardware Range ~Hardware Range———————————————————
& Default & Defaul & Default  Default
" Selected © Selected ' Selected © Selected
Hardware Points Range [1-24 Hardware: Points Rangs [1-24 Hardware Foirts Range [1-24 Hardware Points Range [1-24
UC16 Analog Points UC16 Digital Points UC16 Analog Points UC16 Digital Points
Module Rang Module Rang: Module Rang Fi Module Rang
& mssocisted @ Detault @ Associated @ Default " Associated  Default " Associated & Default
© Selected © Selecled © Selecled © Selected  Automatic € Selected o) s € Selected
File Aange 11-255 File FRange [1-258 Fie Range |1-255 File Flange [1238

(B8 73l577
Cancel Cancel Cancel Cancel

Note:

i
i
ik

Files
If Associated is selected then each Field Controller’s Associated file (see page 13) will be used.

If Download is set as the Batch direction, then there will be a Selected option. If Upload is selected there will
be an Automatic option.

If Selected is chosen during Download, then the Open dialog will be displayed to allow you to select a
specific Strategy file to send to all Field Controllers on the Site. This will have the extension .s32 (UC32) or

.stg (UC16).
The File box will show the name of the selected file.

If Automatic is selected during Upload, then the Points information received from the Cylon® Site will be
stored in files automatically created by the Site Organizer.

Module Range (UC16 only)
If Default is selected, then all of the analog points will be included.

If Selected is chosen, then only the points (of the specified type) that are specified in the Range field will be
included.

It is possible to specify a range of points such as 1,12,16-20,44,
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Virtual Range / Hardware Range (UC32 only)

In UC32 Field Controllers the points to be affected by this procedure are defined in the Hardware Range and
Virtual Range sections of the relevant Points dialog. Two ranges must be defined, because UC32 controllers
can have both I/0 (hardware) points and Strategy (virtual) points numbered between 1 and 24 (hardware
points can be anywhere in the range 1-24, and virtual points can be anywhere in the range 1-1024).

In each case, if Default is selected, then all of the points of that type will be included. If Selected is chosen,
then only the points of that type that are specified in the relevant Range field will be included.
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STRATEGY
Clicking on the Strategy... button in the Field Controller Instructions dialog box opens the Strategy dialog.
UC32 Strategy
Files——————————  Module Range
* Agzociated % Default
" Selected " Selected
File I Fange |1'1U24
Setup
¥ Send
 Automatic
@ Selected
Cancel |
Modules I

Files
If Associated is selected then each Field Controller’s Associated file (see page 13) will be used.

If Download is set as the Batch direction, then there will be a Selected option. If Upload is selected there will
be an Automatic option.

If Selected is chosen during Download, then the Open dialog will be displayed to allow you to select a
specific file to send to all Field Controllers on the Site. This will have the extension .s32 (UC32) or .stg
(Ucie).

The File box will show the name of the selected file.

If Automatic is selected during Upload, then the information received from the Cylon® Site will be stored in
files automatically created by the Site Organizer.

Module Range
If Default is selected, then all of the Strategy modules will be included.

If Selected is chosen, then only the modules specified in the Range field will be included.

It is possible to specify a range of points suchas 1,12,16-20, 44,

Setup

The controller Setup is basic configuration information stored in a controller, indicating how many
Strategy modules it should expect to service, how quickly it should service them etc., along with some
information useful to an Engineer configuring the Site.

If Send is checked, the number of modules included in the Setup will be included in the Batch and the
Automatic / Selected radio button becomes editable.

If Automatic is chosen then the number of modules included in the Setup is based on the number of
modules in the Strategy.

If Selected is chosen, then the number of modules included in the Setup is set in the Modules field.
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STATISTICS

Note: This is only available in Upload Mode.

When this instruction is run as part of a batch, a report is generated that is stored in a file and may also
be printed out on the current printer. The report is stored as a .csv (comma-separated value) file. It is
saved in the \Unitronuc32\LAN\Archive directory. The filename used for the report is displayed in the
Report Log when the Instruction is run.

UC32 Statistical Report

—Ihzlude

v Setup v Send To Printer
v “ersion

[V System Stats ¥ Create new file

[ d ba fil
¥ Engineering Stats CLraie L

v Manual Overides
¥ Hand Overides

[T Status In Subnet Cancel |

Setup

If this checkbox is ticked, the Setup statistics will appear in the report. This performs a similar function to
the Get Setup command in CXprofP. Information about the Site and controller is displayed. For example:

Sitename Local Network
ID #001#01

uUcCc4 Rooftop

UCxx AHU 1

Time 12:05 20/06,/00

Advanced Setup

No. Modules 9
Composed 11:34 20/06/00
User ID P
Strat ID 0
Min Service 0
Time Synch 0

©ABB 2020 All Rights Reserved.
Subject to change without notice
WWW.CYLON.COM

MANO135 rev 3



CXproHp Site Organizer | Field Controller Instructions

Version

If this checkbox is ticked, the Version statistics will appear in the report. This performs a similar function
to the Get Version command in CXproP. The version number of the Field Controller is displayed. For
example:

Version ucgs.2.7

System Stats

If this checkbox is ticked, the System statistics will appear in the report. This performs a similar function
to the Get System Statistics command in CXprotb.

System Stats

Last Reset 11:3420/06/00
Setup Ok X

Serviced Blks 9

Bad Blks 0

First Bad Blk 0

Last Bad Blk 0

Engineering Stats

If this checkbox is ticked, the Engineering statistics will appear in the report. This performs a similar
function to the Get Engineering Statistics command in CXprotP. For example:

Engine. Stats
Watchdog X
RTC o
EEPROM o
Bad Blks 0
Resets 0
Crash Detects 0
Comms Chk Errs 0
o480 2020 Al igts Resrve
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Manual Overides

If this checkbox is ticked, information will be included in the report about the number of manual
overrides that have been carried out through the use of CXproP. For example:

Manual Overides

Pts 1-8 00000000

Pts 9-16 X0000000

Hand Overides

If this checkbox is ticked, the Hand Overides statistics will appear in the report. This lists the number of
changes that have been made to the output of a H.O.A. (Hand Off Auto) through the use of the output
switches

Hand Overides

Pts 9-16 00000000

Status in Subnet

If this checkbox is ticked, the Fieldbus (subnet) statistics for the Field Controller will appear in the report.
This command performs a similar function to the Get Subnet Status command in CXproP. The command
displays the status of the selected Field controller within its Fieldbus. For example

Status Servicing?

Online Not Servicing

Send to Printer

If this box is checked, the report will be printed out on the current printer.
If it is not checked, the report will not be printed.
Create new file

If this checkbox is ticked, the statistics will be saved to a new file.

Append to file

If this checkbox is ticked, the statistics will be added to an existing file.
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CXproHP Site Organizer | Firmware Upgrade Instructions

Firmware Upgrade Instructions

If a BACnet Site is selected, it is possible to update the firmware of the Site’s Field Controllers in a batch.
To set up a Firmware upgrade batch:

In the Select menu set the Site and Targets.
In the Instructions menu select Firmware Upgrade...

The Firmware Upgrade dialog will open:

Firmware Upgrade X

Ahways upgrade.
Upgrade if controler version older than:

L 1 e
Upgrade if controller version older than:

Abways Upgrade
Ungrade if controller version older than:

Abways Upgrade
Upgrade if controller version older than:

Always Upgrade.
Uparade if controler version older than:

® Always Upgrade.
O Upgrade if controler version older than:

® Always Upgrade.
O Upgrade if controler version older than:

Always Upgrade.
Uparade if controller version older than:

Retain Strategies on controliers

(@) Restart each controller after each FW Upgrade
() Delay controller restarts unti all upgrades completed

Add to Batch Cancel

Select the . f1x files (for FLXeon controllers) or .bin files (for all other controllers) that represent the
required firmware.

Select whether all controllers will be upgraded (Always Upgrade) or just specific versions (Upgrade if controller
version older than:)

As firmware upgrade requires the controller to be wiped, specify if the Strategy should be backed up
before the upgrade and restored afterwards by checking the Retain Strategy on controller box.

If Retain Strategy on controller is selected, it will be possible to select whether each controller will restart as
soon as its firmware is upgraded (Restart each controller after each FW upgrade), or if all controllers will be
upgraded before any of them restart (Delay controller restarts until all upgrades completed). This second option
will significantly reduce the amount of network traffic, saving time for the overall process.

When the dialog is complete, click Add to Batch to set the Firmware Upgrade to be carried out when Actions
> Run/Complete Batch is next selected, and to close the dialog.

To close the dialog without adding this Firmware Upgrade to the batch, click Cancel.

Note: When the firmware upgrade is run (i.e. when Actions > Run/Complete Batch is next selected) the Instruction
window will list any firmware upgrades as they happen. If Restart each controller after each FW upgrade was
selected, then the setup block sent with each restored Strategy will restart the Controller. However, if
Delay controller restarts until all upgrades completed is selected, then the setup in each strategy will be set to 0
blocks and an extra Setup command will be sent at the end of the Firmware Upgrade process as shown
below:

X H0  Fw Upgrade: CBT32wx_75.7F (€] — [ 002 - Cylon BACnet Router : 002 - 083 - UCU3213\
M H#1 Setup: “set [E) — [ 002 - Cylon BACnet Router : 002 - 063 - UCU3213\
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